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Introduction

The Online National Mosquito Surveillance Database is a single, centrally housed database for all
District Health Board mosquito surveillance which is accessible via the internet. The database is
securely stored by an independent IT company, supplying a degree of physical security that should
protect it against all but the most extreme disasters. It is frequently backed up, and has a power
supply with several backup contingencies, and is also protected by an industrial firewall which has
continually updated virus protection.

The database is managed by the entomologists at the New Zealand BioSecure Entomology
Laboratory (NZBEL) and maintained by an external IT company. Access to the database is only
available to Ministry of Health approved services and is generally limited to District Health Board
Public Health Units.

Database Operation

Mosquito surveillance collection data is entered as individual or multiple sample records by the
sampler which, once saved, can be viewed individually online or various datasets selected and
exported into Microsoft Excel. Entered and saved data can only be edited or deleted by users with
the appropriate permissions.

Negative sample records must be entered routinely, they become automatically “Complete” once
saved, as no further information needs to be added to them by the entomologists. Samplers are
able to edit or add further information if required.

Positive sample records are “Incomplete” until the specimens have been identified in the
laboratory, and the entomologists enter the results and save the “Complete” sample record.

All positive samples entered into the database, but not received by the Entomology Laboratory
after 3 days, will be followed up via email or phone call to locate them. Samples should be entered
on the day of collection.

The database year runs from July 15t to 30™ June and is archived January 1° to December 315t. Al
samples entered each year are archived at end of the following July. Once archived, the sample
records can no longer be altered.

Access

The database is accessed by “Health Boards”. These consist of the 12 actual health boards, and the
NZB entomologists group. Each health board has a number of users which access the database via
the internet.

Users
To access the data on the database, you must be a registered user. There are three database user
levels: sample creator, health board admin and superusers, which are explained below.

The Sample Creator is the first user level. Sample creators are able to add new samples into the
database, run ad hoc search queries and export data for external use. They are also able to edit or
delete their own sample records until the records are archived. A health board may have one or
many sample creators who access the database.

The next level is Health Board Admin. Each PHS usually has only one health board admin who has
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the ability to add new users and suspend old users (for their health board only), in addition to the
capabilities of the sample editor. The health board admin cannot edit or delete archived data.

The highest user level is the Superuser. This level is only available to the NZBEL entomologists and
the database IT staff, who have access to all the data, and are responsible for managing the
database, including updating pages, improving search functions and data archiving etc. They
cannot alter the archived data records.

When a user is no longer required, e.g. an ex-employee, the status of the user can be suspended,
and will no longer appear in the drop-down menus etc. PHU staff should email the laboratory
taxonomy@nzbiosecure.net.nz to arrange this.

New Users

If you are not a registered user, and require access to the database, you should contact your local
Health Board Admin or the NZBEL Entomologists via the taxonomy emalil
(taxonomy@nzbiosecure.net.nz). They will provide you with an access username and password to
access it. You should change your password once you have gained access — this can be accessed
under your name located top right-hand corner (Figure 2).

Once registered, open your internet browser and navigate to database login page, at National
Online Mosquito Database (Figure 1). It is recommended that you bookmark this page or create a
shortcut from your desktop, to save typing the internet address each time you access the database.
The site can also be accessed through the SMSL Website.

NZ BioSecure

Online National Mosquito Surveillance Database

Please sign in

ADNVISION OF Login
SOUTHERN
MONITORING

SERVICES
LTo

Figure 1. Login page for the National Online Mosquito Database.

Logging In
Enter your username and your password and click the “Login” button (Figure 1). The menu page
will appear.
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Figure 2. Left: National Online Mosquito Database main menu. Right: Profile
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Entering SampleInformation
Samples can be entered singularly or in multiple by uploading a csv file.

Entering New Samples
On the welcome page (Figure 2), select “New Sample” from the left-hand menu, a
new “Create Sample” form will appear (Figure 3).

“Main Information”
Select your sampling officer details from the drop-down list. Your Health Board is
automatically entered and cannot be changed.

Enter the location: The location filters the site references and only display the site
references that are saved to them. The locations with TF after them are for
transitional facilities located in the region.

Complete the “Collection Date”: Click on the collection date or calendar and choose
the date. Then select “Next Page” to view Sample Data Tab (Figure 3).

NZ BioSecure Ohakea NZB~

Home  Create Sample
(") Indicates the field 1s required

Main Information Sample Data Trap Data Weather Conditions Attachments Results Al

Main Information

Health Board M
ADIVISICN OF W

SOUTHERN
MONITORING
SERVICES

D Location”

Sample Officer

W Functions
Collaction Date*

» New Sample

» s somgs
» List Site Referances

» AdHoc Search
» Upload Data
» Export Sample Data To KML File

» Quarterly Report

Figure 3. New “Create a Sample” Main Information Tab

“Sample Data”

Several fields are compulsory. They are denoted by the (*) beside the field name (Figure 4). Fields
may contain drop-down menus where you can select from a list. For example, click in the grey box
“Select Site reference Number” and begin to type the site name, and select from the list of
previously entered site references. The information related to this site will autocomplete, with the
exception of “Total Dips” and “Positive Dips”, which will need to be completed for all larval
samples. However, if you have a new site reference that is not already listed, select the green “Add
Reference No.” (the green tab changes to “Cancel”) and enter the new site reference manually
into the “Site Reference No” field. Once saved new references will appear in the list and do not
require entering again. Continue entering sample data field.

Saved details for site references should include the following fields: “Trap Type”, “Reason for
Sampling”, “Attractants”, “GPS East”, “GPS North”, “Habitat Category”, and “Sample Type”.
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n Sample Data Trap Data

Sample Data
Sample Number”

Site Reference No.*
Reason for Sampling”
PositiveNegative Sample*
GPS East*

GPS North”

Total Dips

Postive Dips

Habitat Category”
Sample Type*

Control / Treat

Salinity

Figure 4. New “Sample Data” Tab

NB: The coordinates must be recorded and entered using Latitude and Longitude with degrees,
minutes and seconds (Lat Lon (DMS)) under WGS84 datum following this example.

“GPS East”: 000 00 00.0000 E
“GPS North”: 00 00 00.000 S

It will read like the following on your GPS unit:
Longitude: 174° 54’ 57.836” E; GPS North: 41° 13’ 59.826” S

The coordinates should be entered using the following format in the online database e.g.
GPS East: 174 54 57.836 E; GPS North: 41 13 59.826 S.

Note that when entering the coordinates the following characters are not required (° “* -).

For larval samples, both the “Total Dips” and “Positive Dips” are required to be entered manually,
and for all adult and larval samples collected from traps, the number of “Trap Nights” in the “Trap
Data” tab must be entered.

NB: Enter habitat category: For traps select “Trap option”

NB. The “Positive/Negative” field will automatically display “Positive” and needs to be changed to
“Negative” manually, where required.

“Trap Data”
When complete select “Next Page” Trap Data will be displayed (Figure 5).
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Home  Create Sample
(%) Indicates the field is required

Main Information Sample Data Trap Data Weather Conditions Antachments Results Al

Trap Data

e Yes e

Trap Type Selact Trap Type -

Trap Nights

oD Select Attractant v

Figure 5. New “Trap Data” Tab

NB. The “Trap” field will automatically display “Yes” and needs to be changed to “No” manually,
where required.

Select the correct option from the drop-down list for “Trap”, “Trap Type”, “Attractants” and enter
the number of trap nights.

“Weather Conditions”

The next tab is where information about the weather at the time of sampling is entered (Figure 6).
This can be recorded using a weather app on a smart phone, or the MetService website. The
information includes “Temperature”, “Precipitation”, “Cloud Cover” and “Wind Speed and
direction”.

Home ~ Create Sample
(*) Indicates the field is required

Main Information Sample Data Trap Data Weather Conditions Attachments Results Al

Weather Conditions

Temperature
Preciptation Select Precipitation -

Cloud Cover

Select CloudCover -

Wind Speed (Kmih) and direction

Sample Status | Incomplete v

( ——
Figure 6. “Weather Conditions”

NB. Recording the weather is a requirement for the use of S-methoprene by the EPA and the
conditions must be entered here or as a comment in the “Attachments” page.

“Attachments”
Select “Next Page” to upload “Attachments” (Figure 7).
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Home = Create Sample
(%) Indicates the fiskd is required

Main Information ~ Sample Data  TrapData  Weather Conditions  AMachments  Results  All

Attachments

Upload File
Choose Fils | No file chosen

Comments.

Next Page

Figure 7. “Attachments”

You may attach a file, a photograph or report to samples, by selecting “Choose File”. Your browser
will direct to your file source for selection. When you save the sample form, the file will copy onto
the database and be saved with the sample data. This is ideal for photos of potential breeding
habitats found during 400m surveys. You can add comments in the comments section.

You can save your sample by selecting the Green “Save” Bar at the bottom of the page.
If there are compulsory fields not entered a pop-up will occur (Figure 8) indicating missing data.
Navigate to the correct tab and enter the missing data. Saving can occur at any page.

Required Fields

« Location Required

« GPS East Required

+ GPS North Required

« Trap Nights Required

« Collection Date Required
« Sample Number Required
« Habitat Category Required

Figure 8. Missing data fields

IIA“”
Alternatively, all the sample information can be entered in the “All” tab (Figure 9).
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Home  Create Sample

“1 Indicates the figld is reguired

Main Information Sample Data Trap Data ‘Weather Conditions Attachments Resuls

MidCentral DHE

Ao
oo ]

Sample Numbsr

Ad

Select Site Refersnce No.

Belect Sample Reason

g
Fi

i.e. Longitude 000 00 00.000 E

ie. Latitude 00 00 00.000 5

eg. Tyre=1

eg. Pos Tyre =1, Neg Tyre=10

Select Habitat Category

Select Sample Type

Select Control / Treat

T
e tovgaeooooe __________
ie Lomieo0ows ___
e
[eaPtre=idegtreo
I

Figure 9. All tab
Savingthe Samplelnformation
When all the information for the sample has been entered, click the “Save” button at the bottom
of the page to save the record. The sample is then saved onto the database.
If your sample does not save, i.e. you do not have a “Sample Saved” displayed at the top of the
page (Figure 10). Click on the “back” icon on your internet browser and try clicking “Save” again.

Repeat until the “Sample Saved” message appears on the screen. Failing this, contact your Health
Board Admin or the NZBEL entomologists for assistance.

The sample has been saved to the database!

Figure 10. This legend will appear if the samples have been saved
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Entering Multiple Samples — Upload a CSV
The database has an upload function to add multiple samples in a CSV file. CSV stands for Comma
Delimited Value. The CSV file format and example headers can be downloaded from the SMSL

website (Entomology Laboratory page, Figure 11).

A B [
SAMPLE OFRCER COLLECTION_DATE Locanon
The sample collection date
Thename of the sample formatis
officer which existingin VeyyMMddHHmmss

SMSL's database. Example: 20201112105523

Must have the year,
menth, day, hour,
minutes and seconds
(total of 14 digits).
The Format Cell for
these cells must be
changed to Number
without decimals.

To successfully upload
your C5V do not close
the file while uploading
into the database

Last name first
fallowed by first
name. Example:

Smith lohn database

L]
SURVEILLANCE_TYPE

Port/Airport surveillance

Thelocation name

existingin SMSL's
database.

Must be the exact
location that
already exists inthe

£

SITE_REFERENCE_NO

The site reference name
existingin SMSL's database,

Must be exactly the
same site ref as what
is in the database.

positive

negative

3 [ H ] 1

POSITIVE_NEGATY SAMPLE NUMBER TOTAL DS POSTTIVE DIFS CONTROL_TREAT
Unique samplenumber 1 for Tyre If pasitive 1 for tyre, If negative0 Bt
Pand or other container (how many tatal) S-Methoprene
Example: 151023 Aquatain
Barrier Spray

K L M
TRAR TRAR_TYPE TRAP_NIGHTS
yes Not a Trap
no BG Trap - Adult The number

of nights the

GAT Trap - Adult trap has been
Tyre Trap active since
€02 Baited Light Traf yhp jaek chack.
Please use the Ff:arr:p;:l;;
t
i;::: TYPE checks) 14
= (for fortnight
listed in here. hecks)
checks

It is advisable
to copy and
paste into
your own C5W

N
REASOM_FOR_SAMPLING
Routine Surveillance
Delimiting survey
Enhanced Surveillance
Suspected Interception
A00m survey
1km survey
Public enquiry
Interception

Mega Survey

Please use the exact
REASON_FOR_SAM
PLING listed in here.
It is advisable to
copy and paste into
yaur own CSV file.

o
ATTRACTANTS
BG Lure
CO2 & Light
Water + Lucerna
Watar
Human
Octenol
Octenol & CO2 & Light

Please use the exact
ATTRACTANTS
listed in here. It is
advisable to copy
and paste into your
own C5V file.

P a R
HABITAT_CATEGORY SAMPLE_TYPE COMMENT
Flowing Stream Adult Any additional information
Ponded Stream Larvaeand/for Pupae  about sampleor site. Including
Lake Edge Other the weather conditions.
Swamp Marsh Please use the exact

Permanent Pond SAMPLE_TYPE listed in here.
Temparary Pand

Intermittent Ephemeral Puddle

Natural Container

Artificial Container

Subterranean Habitat Natural

Subterranean Habitat Artificial

Rock pool

Trap Option

Flease use the exact
HABITAT_CATEGORY
listed in here. Itis
advisable to copy and
paste into your awn
=V file.

Figure 11. Web Page Downloads - Excel Headers Examples and CVS Upload Template

To upload multiple samples, download the “CSV example” file from the website (Figure 11). Open
the file and edit it to reflect your own routine surveillance. Enter the sample data to each of the
rows as specified in the header using the correct format (Figure 12). Weather conditions at the
time of sampling should be entered into the “Comment” section.

The CSV file must follow a specific format with specific options for each column (Figure 12), this
cannot be altered. All elements in the CSV file must be copied exactly as they appear in the online
database or the “CSV Example” file provided in the SMS web page.

NB: Samples from new site references need to be entered manually the first time. Alternatively, a
new site reference may be created in the database prior to uploading a CSV file.

NB: The Sample Officer format has changed from November 2020. The correct format is the last
name followed by the first name. Example: Smith John

NB: The date entered must be in the following format yyyy MddHHmMmss
e.g. Original Date: 2020/07//27 09:05:02;

Import Date Format: 20200/27090502
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A B C D E F

Smith John
Smith John
Smith John
Smith John
Smith John
Smith John
Smith John
Smith John
Smith John
Smith John

20201016082006 Heartland K EnhancedSi Heartland K Negative
20201016082006 Heartland K EnhancedSi Heartland K Negative
20201016082006 Heartland K EnhancedSiHeartland + Negative
20201016082006 Heartland K EnhancedSi Heartland K Negative
20201016082006 Heartland K EnhancedSiHeartland k Negative
20201016082006 Heartland k EnhancedSi Heartland F Positive

20201016082006 Heartland F EnhancedSi Heartland - Negative
20201016082006 Heartland K EnhancedSiHeartland F Positive

20201016082006 Heartland K EnhancedSi Heartland K Positive

20201016082006 Heartland K EnhancedSi Heartland K Negative

I T O

12
12

G H 1 | K L

15005
15006
15007
15008
15009
15010
15011
15012
15013
15014

1 0 S-MethopriYes  Tyre Trap

3 0 S-Methoprene  Nota Trap
Yes CO2 Baited
Yes BGTrap-Ai
Yes (CO2 Baited

1 1 S-MethopriYes  Tyre Trap
Yes BGTrap-A

1 1 S-MethopriYes Tyre Trap

3 2 S-Methoprene  NotaTrap
Yes CO2 Baited

M N o P Q R

SAMPLE_OICOLLECTION_DATE LOCATION SURVEILLAISITE_REFER POSITIVE_MNSAMPLE_N!TOT: POSITNCONTROL_"TRAP TRAP_TYPE TRAP_ REASON_F(ATTRACTARN HABITAT_C SAMPLE_TY COMMEP

4 Enhanced S Water Trap Optior Larvae and/or Pupae
4 Enhanced S Water Permanent Larvae and/ Big pond
2 Enhanced S CO2 & Light Trap Optior Adult

2 Enhanced SBG Lure  Trap Optior Adult

2 Enhanced S CO2 & Light Trap Optior Adult

4 Enhanced S Water
2 Enhanced S BG Lure
4 Enhanced S Water Trap Optior Larvae and/or Pupae
4 Enhanced $ Water Permanent Larvae and/ Big pond
2 Enhanced S CO2 & Light Trap Optior Adult

Trap Optior Larvae and/or Pupae
Trap Optior Adult

Figure 12. Example of CSV file with headers and related values the database can read

The cells containing the “Collection Date” must be formatted as number without decimals (Figure
13a &13 b). To do this, select all the dates in your file, right click and select “Format Cells” (Figure
13a) then select “Number”, and enter O for the “Decimal Places” (Figure 13b).

A B C D E
COLLECTION_DATE LOCATION SURVEILLAISITE_REFER

SAMPLE_OFFICER

L

! |Musicante Mariana | 20201016082001 |Heartland - EnhancedS: Heartland F
3 |Musicante Mariana | 20201016082001 |Heartland F EnhancedSt Heartland +
1 |Musicante Mariana | 20201016082001 |Heartland  EnhancedSt Heartland +
5 |Musicante Mariana | 20201016082001 |Heartland F EnhancedSt Heartland +
5 |Musicante Mariana | 20201016082001 |Heartland - EnhancedSt Heartland F
7 |Musicante Mariana | 202010 ;¢ i 38X rtland F
3 |Musicante Mariana | 202010  copy 3gC rtland k
3 |Musicante Mariana 202019 Paste 38V rtland b
0 |Musicante Mariana 202019 Paste Special... A3V rtland b
1 [Musicante Mariana | 202010 Smark Laokup.. A 3L rtland F
2 Thesaurus... A\ ¥R

3

4 Insert...

5 Delete...

6 Clear Contents

7 Filter >

8 Sort >

9

g Insert Comment

1 Format Cells... %1

2 Pick From Drop-down List...

3 Define Name...

4 Hyperlink... 3#K

e

Figure 13a. Changing cell formats

Format Cells

m Alignment  Font  Berder  Fill  Protection
Category: Sample
i) 20201016082001
Currency -
Accounting Decimal places: 0 -
Date Use 1000 Separator (,)
Time
Percentage Negative numbers:
Fraction _1234
Scientific 1234
bl (1234)
Special (1234)
Custom

Figure 13b. Formatting the cells to numbers without
decimals

Save the changes made, ensure your file is saved as a CSV. You can leave the document open while
uploading so you do not have to open it again if you receive an error message while uploading the
file. In a Mac computer you must leave the document open while uploading the CSV file or the
date formatting will revert to the incorrect format.

Login and select “Upload Data” from the left-hand column on the menu page (Figure 14).

NZBEL V7.JULY 2021
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Home  Upload Sample Data

ADVISION OF
SOUTHERN
MONITORING
SERVICES

Lo

B Functions o

» New Sample
# List Samples
# List Site References

# AdHoc Search

» Upload Data

% Export Sample Data To KML File
# Quarterly Report

Figure 14. Upload Data

Select “Browse”, to locate your file, and choose. Select “Upload”.

A popup will display confirming upload success (Figure 15). If certain fields are not entered
correctly, you will get an error message. Common issues when uploading CSV files are discussed
in the next section.

Upload Data

Upload Succeaded.

Figure 15. “Upload Succeeded”

To crosscheck your samples have been entered correctly, go to “Adhoc Search” and search for the
date your samples have been obtained. Open one or two of the samples and check that all of the
fields have been filled in.

CSV upload common issues and how to fix them

Name format for “Sample Officer” is incorrect. When this happens, a popup will appear in the
database (Figure 15). To solve this issue, replace the “Sample Officer” name format in your CSV
with the one displayed in the popup (Figure 15).

Home = Upload Sample Data

Name format for Sample officer is incorrect. Correct one should be Musicante
Mariana

Upload

Figure 15. The Sample Officer format is incorrect

NZBEL V7. JULY 2021 12



NB: The Sample Officer format has changed since November 2020. The correct format is last name
followed by first name. Example: Smith John

The Collection date format is incorrect. When the Collection Date is entered incorrectly a popup
will display pointing out the problem (Figure 16). To solve this issue, check the following: The date
is expressed following the example provided above (yyyyM MddHHmMmMss); The date cell contains
14 digits in total; The cells containing the date in the CSV file have been formatted as number
without decimals (Figures 13a and 13b).

Home = Upload Sample Data

Process file failed. The collection date format is incorrect. The format must be
YearMonthDayHourMinSec, for example 20120608134523

= Browse ...

Upload

Figure 16. The Collection Date format is incorrect

Site References

The database utilises an automated system for reducing the amount of data entry required for
samples from fixed trap sites. The site details are manually entered into the database once, and
then become automatically linked to the “Site Reference No.” field. From then on, the site detail
fields are automatically filled in, once the appropriate “Site Reference No.” has been selected from
the drop-down list.

NB: Once a “Site Reference No: has been assigned to a “Location” by a sample creator, the
“Location” cannot be changed. To modify the “Location” assigned to a particular “Site Reference
No” you will need to contact the Lab.

Listing Site References

Click on the 'List Site References' link on the left Menu, and all the site references for your Health
Board will be displayed. From this page, you may add to the information relating to a particular
site reference by clicking on 'Edit' adjacent to it (Figure 17).
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Home Site References

Creaie New Site Reference
ADIVISION OF earct T N Admin v

SOUTHERN
MONITORING
SERVICES
LTD
References Per Page |20
M Functions - )
Health Board ¥ Site Reference No.¥
» New Sample MidCentral DHB Arrivals terminal A m
» List Samples
MidCentral DHB Arrivals terminal m
» List Site References
MidCentral DHB Fire fighting tank
» AdHoc Search
» Upload Data MidCentral DHB NZB_OHA_Tyre 1 Spotless m

Figure 17. List Site References

To add a new site reference, click on the blue button “Create New Site Reference” link from the
“List Site References” (Figure 17). Fill in the appropriate fields and click save (Figure 18). The new
site reference will automatically appear in the dropdown menu for the next new sample you enter.
Don’t forget to add the correct location to the site reference. The database filters the site
references by location when creating a new sample. The location can only be altered by the lab
once the site reference is saved.

Home ' Create Site Reference

Health Board MidCentral DHB v
Site Reference No. Site Reference

GPS East i.e. Longitude 000 00 00.000 E

GPS North i.e. Latitude 00 Q0 00.000 S

Trap Type Select Trap Type v
Reason for Sampling Select Sample Reason v
Attractants Select Attractant v
Trap Yes v
Habitat Category Select Habitat Category v
Sample Type Select Sample Type v
Salinity Salinity

Sample Location Select Location v
Contral / Treat Select Control / Treat v

m Back to Main List

Figure 18. Creating a new Site Reference

NZBEL V7. JULY 2021 14



Searching for Samples in the Database

Listing Samples

The “List Samples” link on the menu page column allows you to view your Health Boards samples

that are in the database. You can list your samples based on their “Status” (All, Complete or
Incomplete), “+VE Sample” (All, Positive, Negative) or “Entry Method” (All, Uploaded or Manual)
or Location. (Figure 19).

In “List Samples” be as selective as possible to find the samples, make your selections and click
“Search”. Your samples will appear in a summary table, from which clicking the green button you
can check the results or edit your samples (Figure 20).

Home = List Samples

Health Board

Nelson Marlborough DHB

Entry Method
All

Create Datey Attached File+

Search Criteria
Status +VE Sampls
A DISION OF . -t -
Incomplete
SOUTHERN Completa
MONITORING
SERVICES
LD
H Functions >
# New Sample Quick Search
# List Site References
#» AdHoc Search
#» Upload Data
» Export Sample Data To KML File
» Quarterly Report
Figure 19. List Samples Link.
Home  List Samples
Search Criteria
Semples Per Pa.ge
Sample Numbers Location or N nple Datey
519975 Christchurch Port Complete Negative 21112m8
519976 Christchurch Port Complets Megative 211128
SJ997T Christchurch Port Complets hegative 211EME
519978 Christchurch Port Complets hegative 211EME
519979 Christchurch Port Complets hegative 211EME
SJ8980 Christchurch Port Complets Positive 21208
519981 Christchurch Port Complets hegative 211EME

You can also search for a specific sample using the sample number in the “Quick
Search” box in the “List Samples” tab (Figure 21).

NZBEL V7.JULY 2021

211112018
2111152018
2111152018
2111152018
2111152018
2111152018
2111152018

Figure 20. List samples.

Location

Select Location
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Delete

Delete

Delete

Delete

Delete

Delete
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NZ BioSecure Carolyn Edgecumbe~

Home  List Samples

Search Criteria

Health Board
Any w
Status +VE Sample Entry Method Location
ADIVISION OF ‘ . . . .
ncomplete | v I " t 1 .
SOUTHERN COmP|ElE elect Location
MONITORING
SERVICES
LTD

e - Quick Search

» New Sample OHKCE158

OHKCE 158 RNZAF Ohakea Complete Negative
» List Samples

Figure 21. Using the Quick Search bar
You can export datasets to your computer, by clicking from the “AdHoc Search” “Export CSV”. And

also “Export Sample Data to KLM File”. Refer to the Exporting Datasets section for more detail on
this (Page 18).
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AdHoc searches
On the Menu page, click on “AdHoc Search” link to produce the Search Samples page (Figure 22).

Home  AdHoc Search
Search Criteria

Hesith Board
MNalson Marlborough DHB

Sample Greator
Sesect Sample Officer

Location

Collection Date From

Collection Date To

GPS East

GPS North

Sample Mumber

Site Aaference Mumber

11}
4]
w
m
=
=
(1]
il
=)
(v}
]
=
=

Survallance Type

Sesect Survaelllence Type

Trep Typs
Sesect Trap Type

FRieason For Sampling

Sesect Sample Reason

Attractants
Sebect Altractant

Trap?

Figure 22. In the AdHoc Search menu refine your search
Most fields from the sample records are included in this page, as they can be used to search and

select the sample records. A single field or a combination of several fields can be used for
searching. This is often the easiest way to search for samples.

Examples of searches; all samples collected on a particular date; all positive samples collected by
a particular sampling officer during the month of April.

NB: A period of time must be entered into the date fields to obtain the search results.
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Once you have entered your criteria, click “Search” and you will be given the listing options as
above in the Listing samples section. You can also export this dataset by clicking the “Export to
CSV” button.

Refer to the Exporting Datasets section below for more detail on this.

Exporting Datasets
Data can be exported readily. The system is windows optimised and is the preferred option.

Ad Hoc Search: Export Option

After you have entered the search parameters for the data you wish to export (using the same
process as an Ad Hoc Search), click on “Export to CSV” or Export XLS (Figure 23). The CSV/XLS
should automatically download to your PC. Once downloaded it can be imported into excel for
viewing.

oo ooy | ooms-

Figure 23. “Ad hoc Search” results. Export to CSV or Export XLS

Opening Exported Datasets in Microsoft Excel

Datasets exported as CSV files, can be imported into Microsoft Excel, for use in data analysis etc.
This may not be automated, as the commonly used separator characters are often used in the data
fields, the data may need to be imported manually depending on software versions.

Once you have exported the CSV file to a known location on your computer, open a new file in
Microsoft Excel. Click on the “Data” menu, or “File” select the “Import” or similar option (e.g. Get
data From Text) or “CSV file” (Figure 24).

Home insert__Pags Layout _Formuias JCHS

r 1 ™ 2| Connecticns A ) ~ T =
fiaiy = =2 |- | v + ? Clear =] - Y - =S v [
gl @Bl &) 21 . A k g B = Do B oo g
From Frem  From MNew Database Refrash _ i} Sort Filter Y’ Advanced Textto Remove Data  Consolidate What-If Group  Ungroup Subt
FileMaker HTML  Text Query All Edit Links Columns Duplicates Validation Analysis
"
Al . fe F G = | = B AIAL < Q ke
A B c , P
~ Favorites Name Date Modified E
1 S R
E Recents H Uploadinspections.csv © Yesterday at 2:43 PM

Bﬁ Documents

22 Dropbox

0N s W

&2 Desktop
g #3; Applications
{? 0 Downloads
- iCloud
13 =
14
15 Cancel

Figure 24. Import CSV

A window will appear and prompt you to browse to the CSV file you wish to open in Excel. Once
selected it will open a wizard that you can follow which assists with opening the file (Figures 25 &
26).
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O Jia varta KevView View
s ] . ~ : -
AL Text Import Wizard - Step 1 of 3 { 4|~

I 4 Ungroup S
The Text Wizard has determined that your data is Fixed Width. .

If this is correct, choose Next, or choose the Data Type that best describes your data. T

© Delimited - Characters such as commas or tabs separate each field.
Fixed width - Fields are aligned in columns with spaces between each field. L

Start import at row: l! o File origin: Macintosh i

Preview of selected data: :
Preview of file /Users/mon/Downloads/sample_20181106_103239.csv.

BampleID|Trap|SiteRef INSPSiteName | GPSEasting| GPSNorthing | HBName | Type | TLAISampleType | SampleReason | Sampleld -
12 1617821GAT| | | | |Auckland DHBIPort/Airport surveillancel|NegativelRoutine! INZB AIALPort||2018-1@-2911111111
1311618991Not @ Trap! | |1 lAuckland DHBIPort/Airport surveillancelS-MethopreneiNegative|Routinel INZB ATALPort|
4 161893 INot @ TrapINZB_ATALPond_2| | 2668817 164651891 Auckland DHB|Port/Airport surveillancel |Larvae|Routine! -
15 161892 INot @ Trap INZB_ATALPond_3| | 2668724 16465055 | Auckland DHB| Port/Airport surveillancel ILarvae|Routine!
16 161891 INot @ Trap INZB_ATALPond_4| | 2668392 | 6464948 | Auckland DHB|Port/Airport surveillancel |Larvae|Routine|
17 16192610vitrap - TyreINZB_ATAL Tyre 111266893016464725]Auckland DHBIPort/Airport surveillance!S-Methopren =
18 16193610vitrop - TyreINZB_ATAL Tyre 211267844916464754 |Auckland DHBIPort/Airport surveillancelS-Methoprery
[9116193510vitrap - TyreINZB_AIAL Tyre 3112678724 16464917 | Auckland DHBIPort/Airport surveillance!S-Methoprery

Cancel Jack Finish -

Figure 25. Select “Delimited” and then click “Next”

~ - o} -
{ Text Import Wizard - Step 2 of 3 I IR
i + Ungroup St
This screen lets you set the delimiters your data contains. E

E Delimiters P
Tab Treat consecutive delimiters as one

7 Semicolon Text qualifier: " L
y Comma B

Space

~ Preview of selected data: 3

iteRef iteName PSEasting ing HBName ype
land DHB ‘Airport surveil
land DHB ‘Airport survei

= B_ATALPond_2 668817 189 land DHB ‘Airport survei H—

« B_ATALPond_3 668724 S land DHB Airport survei -
B_AIALPond_4 668392 948 land DHB Airport survei

- B_AIAL Tyre 1 668930 725 land DHB ‘Airport survei =

| B_AIAL Tyre 2 670449 754 land DHB ‘Airport survei L
B_ATAL Tyre 3 670724 17 land DHB Airport survei

— Cancel < Back Finish =

Figure 26. Uncheck the “Tab” box, check the “Other” box and add type in “I” (this is usually the
shift \ button, above 'enter' on the keyboard). Click “Next”
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Click “Finish” to add the data to your worksheet where you can review and analyse. Save it as a
Microsoft Excel spreadsheet file.

Datasets that are exported as XLS can be opened without delimiting the data.

Exporting to KMIL
Exporting sample data to KML enables a google earth viewing of sample data and results.

NB: In order for the data to be displayed accurately, the GPS data entered must be accurate and
the coordinate information needs to follow the format described in page 6.

Select the export option from the menu (Figure 27) and complete the search parameters, as

minimum collection dates must be selected. Then select the “Export KML” tab at the bottom of
the page, a file will automatically be download (Figure 28).

Home = Export Samples to KML

Select Database
Current
Health Board
Select Healthboard
A DIVISION OF
SOUTHERN Sample Creator
MONITORING Select Sample Officer
SERVICES
LTD Location
& Functions &
» New Sample Collection Date From
» List Samples
» List Site References Collection Date To
» AdHoc Search
» Upload Data GPS East
» Export Sample Data To KML File
» Quarterly Report GPS North

Figure 27. Export Sample Data to KLM

Downloads

~. SampleData 2018-11-06_11-35-09
= 101KB

Figure 28. Export KLM button & File Downloaded

Open the downloaded file with google earth and the samples will automatically load. Red pins —
Exotic Species, Yellow Pins — non-exotic positive results and Green Pins — Negative (Figure 30).

NB By clicking in the pin the sample information, including results are displayed (Figure 29).
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SMC1787

611838“

AN > SM(
,,‘SYls:()O‘JM.OA‘lOl]h .-;. 4 C1785,
Places SMC]SSi? i (&
: Y SMCillg40
v & [no name] SMC1784

Sample Number -

Collection Date - 23/12/2017
v & [no name

Sample Number -

Collection Date - 23/12/2017
v & SMC1776

Sample Number - SMC1776

Collection Date - 23/12/2017
v & [no name]

Sample Number -

Collection Date - 23/12/2017
v & [no name

Sample Number -

Collection Date - 23/12/2017
v & [no name

Sample Number -

Collection Date - 23/12/2017
v & [no name

Sample Number -

Collection Date - 23/12/2017
v & [no name]

Sample Number -

Collection Date - 23/12/2017
v & [noname

Qamnla Nimhar -

SMC1776

Sample Number - SMC1776
Collection Date - 23/12/2017
Collector - NZB AlALPort
Site Ref - NZB_AIAL_BG6
Trap Type - N/A
Samplz/n'pe - Adult
Positive/Negative Sample -
Positive

Sample Results:

Exotic species:
1 Female Aedes aegypti

Directions: To here - From here

Figure 29. KLM Samples displayed

The following clearly depicts what an error in entered GPS data looks like when exported as a KLM
(Figure 30). Please ensure GPS data is recorded in the correct format and for the correct location.

SY12663M-090418 ‘YSYLZGZM\‘I—IJOZLS
SY12623M-140218 /7SY12661M-090418
B

‘BTGG‘)

Data SIO, NOAA, U.S. Navy, NGA, GEBCO
Image Landsat / Copernicus
© 2018 Google

Figure 30. Incorrect GPS Co-ordinate example
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Finishing a Session

When you have finished with the database, click on your name at the top right of the current
screen and you will be returned to the menu page. Click “Logout” to terminate your connection
(Figure 31).

@Profile
® Logout

Welcome, MaryMusi

Please select a function or administration action in the left task bar.

A DIVISION OF

SOUTHERN
MONITORING
SERVICES

LD

Figure 31. Logout.
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Thank You

If you have any queries, please
Email us at the NZBE Laboratory

taxonomy@nzbiosecure.net.nz

A Division of Southern Monitoring Services Limited
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